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In this thesis the author presents theoretical grackad of GUI test automation as well
as technologies, tools and methodologies requoddlly understand the test program
written in SWTBot. Practical part of the thesis viasmplement a program testing File
Menu options of Pegasus RCP application develop&tbkia Siemens Networks.

Concluding this dissertation, in the author's opimitest programs written using
SWTBot are relatively easy to read and intuitivegeople familiar with basic concepts
of Eclipse RCP. Without any doubt SWTBot's API &de enough to test effectively
such complex application as Pegasus RCP. The higgasiem could be lack of good
documentation and tutorials which makes it diffidol start with. The best and most up
to date is Javadoc that comes with SWTBot's cotherdfore a developer which wants
to start writing SWTBot tests has to spend some tiith it to get familiar with the API
experimenting with the code. Although SWTBot is aotommercial tool, the growing
community of testers and developers using it segmising considering the need of
support. Despite of what is published on SWTBot@mke page, SWTBot lacks
a recorder which implicates that the tester hdset@ programmer. As the analysis has
shown the automated tests execute over twenty thaster comparing with manual
tests.

Pieces of code presented in this document, inghngthow to achieve tests
independence, error recovery, and test synchrooigabgether with big test program
implementation (APPENDIX 2) make up a great tuiowdich will help developers
to get familiar with SWTBot’s capabilities. FileMehest.java consists of 30 test cases
and has almost 1500 lines of code. The author laerthose tests compliant with all
the objectives for well-designed test cases. Thgnam was integrated with the nightly
builds of CruiseControl, which means the authorgshknis utilised on a daily basis.
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MARKINGS AND ABBREVIATIONS

SWTBot

SWT

Eclipse RCP

Pegasus RCP

JUnit

Agile

Scrum

record/playback

bug

AUT

test case

GUI

NSN

SWTBot is an open-source Java based GUI testinddoo
SWT and Eclipse based applications.

Standard Widget Toolkit is an open-source lgicg widget
toolkit for Java platform (alternative for AWT aigiving).

Eclipse Rich Client Platform is a framework to bullava
applications that have look-and-feel of native aapilons. It

utilises Equinox OSGI, plug-in architecture, SWTHalrace

Pegasus test automation framewo&NsNbroduct for all
kinds of tests: regression, reliability, stabilipyptocol tests,
performance measurements. Pegasus is used mostly in

telecommunication branch. It is the AUT in thissisework.

JUnit is a unit testing framework for the Java pamgming

language.

Agile software development refers to a grafigoftware

development methodologies which follow Agile Masife.

Scrum is a popular Agile methodology. It is anatare

incremental framework for managing software prgect

A mechanism that allows recordisgr actions and

replaying them. Can also be referred to as capapiey.

A defect that can make a program to crash, givepeeed

output or just causes inconvenience to the user.

Application Under Test. The application, pratiisubsystem,
or component that is being tested.

The smallest unit of a test. A subroutine thatstessingle

aspect (or function) of the AUT.
Graphical User Interface

Nokia Siemens Networks
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1 INTRODUCTION

1.1 Rationale and Background of the Project

The topic of this dissertatio®UI Test Automation with SWTBot was a natural

choice for the author since he had to become SWHpetialist for Pegasus
project held in Nokia Siemens Networks Software &epment Centre in

Wroclaw. The purpose of automating GUI tests wasi¢cease the code coverage
for parts of the code which could not be testechwit/nit (user interface), and
therefore increasing the quality of the developeftwsare. SWTBot as an open
source, Java based functional testing tool targeied(SWT and Eclipse based

applications seemed the best choice for this task.
1.2 Aims and Restrictions

Testing is an invincible part of software developtprocess, especially when
using Agile methodologies. In this thesis the authmtroduces theoretical
background of test automation as well as technefygiools and methodologies
used in the project. Practical part of the thesimswto implement
a program testing File Menu options of Pegasusiemn. The program was
later integrated with the nightly builds of Cruisw@rol, which means the author’'s
work is utilised on a daily basis. The thesis doenmitself was already used
as a guide for Pegasus team members and other tled®N considering using
SWTBot in their projects. SWTBot is still an inctio& project and this itself
makes it challenging and innovative to work wittedper analysis and calculating
return on investment for the test automation ptojegs not possible because the

author was not allowed to disclose any financikdtesl data about NSN.
1.3 Materials for Thesis Writing

Literature for thesis writing consists of latestopcations available in the field
of GUI test automation. Materials used range froooks and articles written
by greatest authorities in the field of test autbama through professional
periodicals, to projects’ official home pages. \Mgttest program required mostly
studying SWTBot’'s Javadoc and a lot of hands-oreggpce.
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2 THEORY OF GUI TEST AUTOMATION

2.1 Introduction and Background

Modern software applications become more and mongptex. This applies also
to graphical user interfaces (GUIs) being impleradntoffering enhanced ease
of use, and of course higher profit to the vendtoseems to be obvious that the
GUI code should be tested. First commercial GUt tesls started to appear
in the late 1980s. They provided possibility to terriest scripts manipulating

the graphical user interface identically as a humauald use it.

Since then many software companies tried to apferdnt GUI test tools
in their projects. The rationale behind it was ligyudhe same: because manual
testing is costly, therefore we should focus odorefon automating the tests
so that they could be run repeatedly, which shgiv@ more time to test new
features instead of retesting the old code. Buhaut proper tools and - even
more importantly — proper methodology for designemyd building GUI tests
suites, the investments usually did not pay of6y&tematic approach to planning,
designing, building flexible and maintainable autded test suites needs
to be employed. An approach that would bring th&t beit of the testing efforts.
(Fewster, Graham 1994, 517; Hutcheson 2003, 4-20.)

2.2  Why Do We Need a Methodology for GUI Testing?

A question can be asked: why do we need a methggdldvhat makes GUI
testing unlike any other form of automated testiiig® answer lies in the nature

of graphical user interfaces and the way they axeldped and maintained.

1. TheGUI changes more often than the business logihat it invokes.
Introducing new functionality to the applicationterd requires GUI
reorganization to be able to present the new dmatadoherent way. This
implicates that more effort needs to be put intontemance as it becomes
very probable that new versions will break the ExgsGUI tests. Business

logic tests, like unit tests, seem much more static
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AUT’'s GUI complexity. There are usually several ways to perform
a given operation, which translates into more thittgtest.

GUI test tools complexity Majority of GUI test tools available
on the market have their own robust scripting laggu GUI test tools
have to run as a separate process from the AUT hwhexuires
synchronizing test execution speed with the spdedctons performed
on the application. Large number of GUI controls e manipulated
and queried entails the large API that has to halabe to the script

writer.

Custom controls handling is difficult. Modern GUI test tools can handle
the common controls in an abstract way, utilisiaghantics corresponding
with the function of the control, e.gutton(*OK”).click(). Dealing with
custom controls usually has to be handled in a peiyitive way, like
usingx andy screen coordinates which makes the test scrifiexible.
(Fewster, Graham 1994, 519; Patton, Ron 2005, 324)

2.3 The Benefits of Test Automation

Test automation enables some testing tasks to eeuted far more efficiently

in comparison with manual testing. It has many bB&nencluding those listed
below (Fewster, Graham 1994, 9-10; Graham, Veeranéaans, Black 2007,

185):

1.

Run existing tests on a new version of a programrhis is probably
the most obvious objective for the tests. Testraateon should minimise
the effort used to perform regression testing. Tdsts that worked with

the previous version of the program should als@ pasthe latest version.

Run more tests more often A visible benefit of test automation
is the capability to run many tests in less ticheyéfore making it possible
to run them more frequently. This leads to incrdasmnfidence

in the system.
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. Execute tests difficult or impossible to do manuajl. Trying to perform
a live test of an online system with say 500 usesslld be impossible
to do but the input from 500 users can easily brikited using automated
tests. Automated tests can be run by technicalopewgho do not have
to know all the complexities of the application, eren by another tool
like CruiseControl

. Tests reusability. The efforts and costs put into designing, bugdand
making tests highly reliable can be distributedrov@any runs of those
tests. Writing modular and reliable code improves quality and speeds

up building of new tests.

. Better use of resourcesBy automating time consuming and boring tasks,
like entering long list of test inputs, one can e the staff morale and
free the skilled testers to be creative and putenarergy into designing
better test cases to be executed. Also computerdeaused to run the

tests instead of being idle overnight or at thekeed.

. Coherency and repeatability of tests Tests which are repeated
automatically will be repeated exactly each timé.cQurse this assumes
that tests are synchronised well with the AUT. Aligh automation offers
a level of consistency that is very difficult toha&ve in manual tests.
The same tests can be run on different hardwareopedating systems.
This can confirm cross-platform quality and coresisty which would

be costly and almost impossible to accomplish wiinual testing.

. Increased confidence If an application passes extensive set of well
designed automated tests, there can be higher deoci that
no unpleasant surprise will show up in the releasadion. The tester can
make more profound testing with less effort, rasglwith higher quality
and productivity.

Earlier time to market. After you automate a set of tests, they can

be executed much faster than they would be manukttigrefore the time
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needed to test application decreases and develagersstart fixing

the bugs earlier.
2.4 The Risks of Test Automation

While trying to automate testing a number of praidecan be encountered.
Realising the possible problems is needed to be tabavoid them or overcome
them. The most common risks are listed below (Fewstraham 1994, 9-10;
Graham, Veenendaal, Evans, Black 2007, 186-187):

1. Poor testing practices When the tests are poor quality, badly organised
and designed, with none or ambiguous documentatiibh little chance to
find any bug, than there is no sense to automata.tiihe focus should be
to better the testing effectiveness first rathemtlimproving efficiency.

After automating chaos, all you get is a fasteiosha

2. Unrealistic expectations Testing tools vendors promise that their tool
will solve all your problems. Ecstatic enthusiasinnaarketing people
and salesmen is contagious. Vendors obviously esipi#he benefits that
can be achieved, examples of (real or not) impldéatem victories,
in the same time playing down the amount of eff@éded to get lasting
benefits. If this wild optimism will translate intdbanagement’s unrealistic
expectations, than no matter how close to perfedte tool is, it will

not meet the expectations.

3. Anticipation that automated tests should find many new bugs
The biggest probability to find a defect is duritige first time the test
iIs run. Rerunning the same test gives much les®apibity to find
a new bug, unless application’s code was changedsél changes could
brake application’s functionalities directly or inectly. Other possibility
to rise chances to find a defect is to rerun tisesten a different hardware
or software environment. Tests which do not finfedes are not useless.

Although a well designed test should aim at findohefects, however
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passing test suits can give the confidence that dhanges made

in the code did not break previously implementattfionalities.

. Tests maintenance After some changes have been made in the
application under test it is often inevitable taape some, or in the worst
case scenario all test so that they could be reut@d successfully.
The effort required for tests maintenance was oftka last nail

in the coffin for many test automation initiativel. it is less time
consuming to rewrite the test than just update thémen the test
automation is very likely to be ceased. This disdem aims to help the

reader not to become a victim of excessive maimemaosts.

False confidence Only because a test suite executed successtullges

not mean that the software is faultless. The tdstmselves can contain
defects or they can be just incomplete. There w&@ayd a chance that
the tester has unconsciously implemented testshwban preserve the

incorrect results for indefinite time.

. Technical problems and lack of customer supportTest execution tools
are third-party software products which themselaes not error proof.
This is not a good showcase if testing tool is patperly tested itself,
although it does happen. When choosing a testiobdoe should also
take into consideration if there is technical suppr the product
or at least active community of product’s usersm@eercial test execution
tools are usually big and complex products andreskte technical know-
how is needed to gain the best out of them. Thezetowould be good
if tool vendor would offer training or at least ersive documentation
for the future test automation engineers. Additipnao technical

problems with test automation tool you can encautgehnical problems
with the application under test itself. Applicatiaga be tested should
be designed and implemented with testability indnso that it would not

be difficult to test it automatically or manually.
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7. Organizational issues Test automation needs support and understanding
from the management and it requires to be fit itite culture of the
organization. Time is needed for choosing the ritgdl, for training,
experimenting and getting hands on experience fandromoting use of
the tool within the organisation. Having a kindtobl champion would
increase radically the probability of success. Aar@matic person
enthusiastic about tests automation could helpt dolgpromote the tool
within the organisation. Start-up costs are alwesiatively high when
introducing test automation, therefore a long teapproach needs
to be used. Not introducing standards from the V&ginning can cause
that incoherent approaches to test automation léllused, which can
make it difficult to transfer and share automatesis and testers between
teams. Also tool’s licensing has to be carefullgught over. Having too
few licenses for people who want to use the toallc¢d@ffect the success
and cost of the test automation effort. Percepbbrwork effort needs
to be reviewed. Even if tests run automaticallyroight, their results need
to reviewed and analysed by the tester. Test ardbhgzomes a separate
activity comparing with manual tests, where it warsbedded in test

execution activity.
2.5 Test Planning and Design

Relevant test planning is needed to be successfapplying automated testing.
Testing effort has to be planned as any other asplesoftware development
process. But especially in case of GUI testings ibard to fight the temptation
to trifle and neglect the planning stage, as: igsis supposed to be simple
(especially with record/playback), the testing codéll not be shipped
to the customer anyway, and the deadlines are smHhiet’s better get to write the
tests immediately”. Neglecting the need of propnping and design is false
economy. The quality of planning and design donee“ahe fly” while
implementing the tests would be poor. Therefores ifundamental to treat test
planning as a separate intellectual effort fromlenmgenting the tests. As analysed
in the previous chapter, GUI test automation ifiaift:



15 (50)

» Test planning and design is hard to do properly
e Learning to use testing tool properly is time conswg
* Writing and debugging the test scripts is difficult

Trying to do all those tasks in the same time wowmldke them even harder.
(Pettichord 2001; Fewster, Graham 1994, 9-10)

2.5.1 The Purpose of Test Documentation

Test documentation has two main functions: it stiooé acommunications
vehicle and ablueprint for development. Contents of the documents will
be of more significance than their form. The tepecification is a kind
of functional specification for testing. Its levef detail depends on the needs
of the specific project. It usually covers topideel testing environment, testing
scope, risks, staffing needs, etc. Test spedidicatan be treated as a kind
of checklist to insure that all activities followne plan and schedule accepted
by management. If the company does not yet havefavare specification
document to follow, a good template to start welcontained in IEEE Standard
829 — IEEE Standard for Test Documentation.

The test design acts as a blueprint, a detailedrigésn of what will be tested
(and what not), and how each test case should piemented. In the simplest
form a test plan can be just a list of tests. A tese design should consist

of at least:

Test name or ID which should uniquely identify thet.
e Test purpose: short description of what the testipggposed to do.

» Test method: clear steps which should allow the tseerform a given

test manually.

+ Pass/Fail criteria: how to tell if the test if ttest works.
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Putting the effort to create test documentationlescribed above has several

advantages:

1. It allows reviewing the test plan and gives anptete overview
of tasks to be done. During test reviews the tehoulsl make

mindful trade-offs to improve the tests.

2. It gives a basis for deciding which test caseautomate. In case
of GUI tests not everything can be automated. Awenemore
importantly, not everything is possible to automaist effectively.
Good example of operation which should be leftrf@nual tests
is printing. From the reviewed and accepted listests the ones
that can not or should not be automated should egeegated.

These tests should be added to manual testing ledteck

3. It provides the basic test case documentatioichwican give
a general view of the tests. It improves maintaiitgbof tests.
More detailed documentation should be includedhe testing

code comments.

4. GUI test design process discovers bugs. Thishés strongest
argument for doing test design. The surprising facthat while
composing test cases and clicking through apptinadi lot of bugs
can be found before even starting to write autochageripts.
This is an interesting issue worth of discussingainseparate
chapter. (Fewster, Graham 1994, 522-525; Institit&lectrical

and Electronics Engineers, Inc. 1998)
2.5.2 Finding Bugs During Test Design Process

As mentioned in previous chapter the surprising iathat during writing detailed

GUI test designs many bugs in application can hendoeven before starting
to write test code. To begin with making detailedttplans usually the tester
has to wait till the GUI stabilises. Luckily mode@UI builders allow engineers

to build and modify complex user interfaces in venprt time. While writing test
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design document the tester performs manual testgting this document

is often a first time anyone has systematicallyeshe user interface. Taking
into account the complexity of modern GUISs, it ist rsurprising that plenty

of defects are discovered. This denies the widetepted opinion that “if you

commit to building an automated GUI Test Suite, tlerpect it to pay off during

the current release”. Usually approximately halftioé defects are discovered
during test design phase as a result of creatingstacase to specifically test
for that certain condition. Other bugs will be digered incidentally,

like misspelled labels in dialog windows or missiiegns. The bugs reported
range from trivial (e.g. inconsistent labels inldia File name; File Namé

to serious which crash the application under test.

The fact that till the test automation documentréady many defects will
be discovered should be used to gain a kind ofidente credit inside the
company. Even if the schedule is so tight thatdig automated tests will not be
possible, documenting the manual testing actiore way described in previous
chapters is still an excellent way of finding bugsd in the same time making
a big step towards test automation. (Fewster, Gnab@94, 525-526; Pettichord
2001)

2.6 Well-designed Test Cases

After test specification and design have been cetedl and reviewed, it is time
to begin writing the tests. The effort put into atieg well-designed Test Suites

Is to satisfy fundamental objectives.
* They must be maintainable
e They must be modular
e They must be robust
* They must be well documented

* They should be built of reusable components
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The ideal tests should possess those attributesvs(Er, Graham 1994, 527;
Myers 2004, 43-44.)

2.6.1 A Test Case Is Independent

Every test case has to take care of its own setrapfication, and clean-up.
In the set-up phase application should be broumlat state where the actual test
can be executed. In verification phase the actestirty is performed, results
are evaluated to a pass/fail status. Clean-up pslageld bring the application
back to a state from before setup — so called btde — to make it ready for the
next test. If a test case would rely on the resoiltthe previous test case, then
if the first test case would fail, it would mostdly cause failure of the preceding
test case. Such cascading errors would make itdifigult to find what the root
cause of these failures was. It also enforces onplirdering of the test cases
which in practice is rarely documented. Unconscioesrdering of test case
execution (e.g. by a tester or testing framewodgld cause a chain of failures
in a Test Suite which executed faultlessly the jmev day. Test cases should be
executable in any sequence. This allows the maietdad choose a subset of test
cases to run without having to concern the intezddpncies between test cases.
This is sometimes hard to apply in practice. Fatstehat modify a complex
global state (e.g. creating or modifying a datapasginning all tests from zero
for each test case would be far too expensiveuth situations test cases relying
on specific state can be grouped together butniteedependencies between them
should be well documented to help future maintaeranalyse such a Test Suite
(Fewster, Graham 1994, 527.)

2.6.2 A Test Case Has a Single Purpose

An ideal test case should have a single purposs.should help keeping the code
relatively short and simple to make it easy to ust@ad, debug, and maintain.
Moreover it also means that the outcome of the dasé should always be one
of the two: pass or fail. This makes it much eaweinterpret the results. In case

of failure of a single purpose test case it isidtito locate the application function



19 (50)

at fault. This implicates that a Test Suite shawddsist of many smaller test cases

instead of few large ones (Fewster, Graham 1994523.)
2.6.3 Unsuccessful Test Case Should Not Cause Othe&r Fail

A test case that fails due to an unexpected ereawvels the application
in an unknown state. The AUT is out of synch withhalv the test case
iIs expecting. A well-behaved test should log thiufa, abort and reset the
application to a known base state. It is a tasla ¢ést tool to isolate test case
failures so that an unexpected error in one test daes not cause a whole script
to abort. All of the most popular GUI test toolsowyde this functionality
(Fewster, Graham 1994, 528.)

2.6.4 A Test Case Is Well Documented

As already mentioned, one of the advantages ofngra good test design is that
you can take the test case description from thesish@nt and use them as header
comments in the test code. Of course also in-liomments should be used

to describe the logic when necessary.

All attributes discussed in chapter 2.6 make upiiregqments for well-designed
test cases (Fewster, Graham 1994, 528.)

2.7 Standardised error recovery

There are many things besides a bug in the AUT lwioien cause a test case
to fail. It could be a bug in the testing code, iemvmental error (e.g. network
connection down, no disk space), intentional changle application, excessive
machine load causing timing errors, etc. All thederm GUI tools have built-in
ability to detect an error, log it (with tracebackihd move on to the next test case.

The problem is that when the test crashes, it B#we application in an unknown
state and unless some actions are taken to resefAWT to a known state,
subsequent tests are likely to fail. A base statesually main window open,
active, and not minimized (just as if applicatioasyust started). A good practice
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is to implement the capability of recovering to @ats which would allow
continuing with next test cases. A recovery routioald be for instance:

1. Log the error

2. Abort the test case (because it is in an unknstate)

3. Make attempt to come back to a known state (€age all opened

windows till the main window will be active).
4. Resume execution with the next test case

Implementing those steps should allow executiorthef consequent test cases
(Fewster, Graham 1994, 528-533.)

2.8 Testing in Agile Development Environment
2.8.1 Agile Methodology

Agile methodologies started to become widely usedha beginning of this
decade. To name just a few: Scrum, Extreme ProgmginCrystal, FDD,
and DSDM are probably most popular. What they alehin common was
gathered in so called Agile Manifesto publishe@®®1 (Beck, et al. 2001):

Manifesto for Agile Software Development

We are uncovering better ways of developing
software by doing it and helping others do it.
Through this work we have come to value:
Individuals and interactions over processes and tools
Working software over comprehensive documentation
Customer collaboration over contract negotiation
Responding to change over following the plan

That is, while there is value in the items on

the right, we value the items on the left more.
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Using the values from the Manifesto it is posstbleleliver small chunks

of business value in very short release cycles\{2dks).
2.8.2 Agile Testing

Everyone in Agile team is a tester. Anyone can qgretftesting tasks. If that
is true, than what is the role of an agile test®n?Agile tester is a professional
tester who embraces change, collaborates well both business and technical
people, understands the concept of using testsve development and document
requirements. Agile testers are willing to learnatvhustomers do to understand

better what users’ and customers’ software requergmare.

Ten principles for Agile testers listed below were derived from the Agile

Manifesto and so called Twelve Principles of Ad@leftware (Beck, et al. 2001):

1. Provide continuous feedback If tests drive Agile projects, than it's
no surprise that feedback is very important in Agiéam. Tester plays
a role of information provider within a team. Helgee the customer
to articulate requirements for each story in thenfof examples and tests.
After that he cooperates with team members to thase requirements

into executable tests which will give meaningfiddback.

2. Deliver value to the customer The tester has influence on quality and
the priority of the pieces of functionality that cshd be delivered

to the customer.

3. Enable face to face communication Agile tester which knows
the application from customer's point of view andhdarstands
the technical aspects and limitations related t@lementing features

can help customers and developers achieve a corflangnage.

4. Have courage Tester should have courage to ask questions|edgal
the ways how things are done, join meetings andersations he wasn't

invited for.
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Keep it simple Test “just enough” with the lightest-weight tools

and techniques that can be found which will dojttoe

Practice continuous improvement Searching for ways to do a better

job should be part of an agile tester’'s mind-set.

Respond to changeAgile testers need to respond to frequently chreng

requirements, priorities and they have to accomnsodaanges.

Self-organize When the Agile team faces a major problem, likeaken
build, it is everyone’s problem. Team members discthe issue right

away and decide how to fix the problem and who dallit.

Focus on people Every team member should have opportunity to grow
and develop his skills. Agile testers are not trdats second-class citizens
in software development world. They contribute weigvalue to their

teams.

Enjoy. Working in environment where all team membersrasponsible
for quality and testing, where everyone collab@atevhere you
are engaged in the project from start to finishh seems like a tester’s

Utopia, therefore enjoy it. (Crispin, Gregory 2029;34.)

2.9 Best Practices Summarised

This chapter will summarise briefly the theory diiGest automation by pointing
out the most important steps which should lead uccessful implementation
of test automation (Fewster, Graham 1994, 534-B8%&jchord 2001.)

Test Project Planning
Create a test plan containing high-level aspecteeproject;
Create a test design document that should be afdvalsst cases creation;

Get official approval of the design before you tstading tests;
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Writing the Tests

Keep the test programs simple and easy to understan

Build independent test cases. Do not rely on tkelte of a previous test

case as a basis for another test case;

Take header comments for each test case from tteptan. Make
the code easy to maintain. Comment and document, wspecially

any workarounds and interdependencies in the tefs; c

Make sure each test case has clear result: pdai; or
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3 SWTBOT IN GUI TEST AUTOMATION

3.1 Introduction to SWTBot

SWTBot is an open-source Java based functiona@&ting tool for testing SWT
and Eclipse based applications. It is a kind otkehobot. SWTBot provides
simple to read and write Application Programmingeifaces. APIs hide
the complexities of SWT and Eclipse, making thdstesore intuitive to write.
SWTBot integrates well with Eclipse, and supportd fasks so that one can run
his builds from within CruiseControl or any otheor@inuous Integration tool.
SWTBot can run on any platform that SWT runs oerefore also with Eclipse
RCP applications. Very few testing tools providgmort for such a variety
of platforms. SWTBot also supplies its own set ebations that are useful
for SWT. After installing SWTBot into Eclipse usinthe SWTBot update
site, a new “Run As...” choice appears (SWTBot TeS)VTBot's test
case classes, SWTBotTestCase (for standalone SWP #&gsting),
and SWTBotEclipseTestCase (for Eclipse SWT plugesting) subclass JUnit’s
TestCase class, so all of the JUnit facilities arailable, plus some extra magic
for accessing SWT widgets:

Figure 1 SWTBot is an API that depends on JUnit andEWT

Many events that SWTBot sends to the Ul are blagkBWT dialogs are a good
example of one of them. What it means in practkdhat functions opening
dialogs will block until the dialog closes. Singe do not want our tests
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to be blocked when a dialog opens up, SWTBot rarssnon-Ul thread, and posts
events to the Ul thread:

4

.
-

Figure 2 SWTBot and threading

In SWT, access to native resources is controlled Bingle Display object. This
object is created by the single Ul thread. She|eatis represent windows and
of course there can be many of them in your apipdica (Pedegaonkar,
Rodrigues 2009)

In December 2008 SWTBot project moved from Sourcgé&oto Eclipse.
It is currently in Incubation Phase of the Eclipsselopment process. This means
that its developers are currently implementingréguirements that a full Eclipse
project must meet in terms of its processes, conitfnand technology. The code
base of the project is already stable and matureveitheless, one have

to be prepared for one or the other change in ke &bert 2009)

3.2 Installation and Configuration of SWTBot
3.2.1 Install Eclipse IDE

SWTBot tests require Eclipse IDE. In case of thgqmt the author was involved
in - Eclipse for RCP/Plug-in Developersshould be installed. It can be found on
the official Eclipse web site: http://www.eclipsegfdownloads/packages/eclipse-

rcpplug-developers/galileor [referenced 15.09.2009]
3.2.2 Install SWTBot Plug-in

Next step is installation of SWTBot plug-in. Thesiest way is to use the update
site: http://download.eclipse.org/technology/swipalileo/dev-build/update-site/
[referenced 15.09.2009]. Using the menu in Eclipgth Help > Software

Updates > Installed Softwarethe following entries should be displayed:
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« SWTBot Eclipse Feature

» SWTBot Feature
Both of them have to be installed and Eclipse ghbel restarted.
3.2.3 Create Test Plug-in

After completion of SWTBot plug-in installation, tast plug-in can be created.
The author advises to use a haming convention ichwime name of the plug-in

is suffixed by.swtbottests Example:
* Plugin to be tested: pegasus.core
e Test plug-in: Pegasus.core.swtbottests

A test plug-in is a normal Eclipse Plug-in. One caeate it in the normal way

by unchecking some options:
* Uncheck <This plug-in will make contributions teeth1>
* Uncheck <Generate an activator, ...>
* Uncheck <Create a plug-in using one of the temgptate

Add the following required plug-in dependenciesytur test plug-in manifest

file:
e org.junit4
e org.eclipse.swtbhot.eclipse.finder
e org.eclipse.swtbot.swt.finder
e org.hamcrest
» org.apache.log4j

* org.eclipse.swt
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e org.eclipse.ui

And last but not the least, the plug-in to be wste
* pegasus.core

3.2.4 Create a Simple Test

Code example InAPPENDIX 1: SimpleExampleTest.java can be added
to the plug-in: pegasus.core.swtbottests.Simplefpkeinest.java. The code can
be used as a skeleton for writing other SWTBotstést Pegasus. The test opens
Run perspective from the menu bar, makes sometiasserthan switches back
to Test perspective. What it does exactly is ngiartant at the moment. Its main
purpose is to check if any SWTBot test can be run.

3.2.5 Run a Test

In order to verify the correctness of steps descrim chapters 3.2.1 to 3.2.4,

running a test is needed:
* PerformRun as SWTBot teston the test clasSimpleExampleTest.java
* Even if the first run leads to errors — it creaegefault run configuration
e PerformRun As / Run Configurations...
* Open theMain tab
e DefineRun a product as pegasus.branding.PegasusRCP
* Run the test

After the test run a JUnit view opens. If the testecute, then everything is ok.

The environment is prepared to write SWTBot tests.
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3.3 Eclipse RCP

RCP provides a generic Eclipse workbench that d@est can extend in order
to construct their own applications. Among manyadages of RCP applications
the most important are: easy to extend plug-in iscture, responsiveness,
native-looking user interface, easy to write helstem. Every Eclipse RCP
application comprises of at least one custom plugnd uses the same
Ul elements as eclipse 3.5 IDE. It is importantgeet familiar with the basic
elements of Eclipse user interface to understandTBMW tests which will
be covered later. Figure 3 shows those elemeniegasus RCP — application
to be tested later:

Page  Menu Bar Editor Tool Bar Perspectives

W Pegasus ACI® workspace - C:\Core$13_old\pegasus.core.product\vorkspace i =] l
Fle Edt Prowct\Run Search Window el

[B= Navigato B2 |2 TestPro |®° Pasemet | = 0|5 thaml (283 tscoal 82 = O[] Pasam 52 55 0utin | = O
o =T .

- Z
|| Ho Parameter List Holder conirol select

5 Editor conten:

I Log Enres Table|

Figure 3 Basic Ul elements of Pegasus RCP

Pegasus RCP — application which the author is geindest with SWTBot
was written using Eclipse RCP framework. It corssist elements like views,
editors, perspectives, etc. This chapter helpgtdagniliar with basic terminology
regarding Eclipse RCP applications which will bénef better understanding
of SWTBot's API covered in consecutive chapters.
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The workbench provides a robust set of classes and interfacesbddding
complex user interfaces. Workbench window (IWorldfefVindow) is the top-
level window in a workbench. It is the frame thatds themenu bar, tool bar,
pages, views, editors, etc. The term workbenchatem be used loosely to refer
to “the window that opens when you start the platfo Next paragraphs describe
the main visual components that make up the wordthen

Inside the workbench window there is op&ge (IWorkbenchPage) that in turn

contains parts. Pages are used for grouping parts.

Perspectivesare an additional layer of organization inside wwkbench page.
A perspective defines an appropriate collection wéws, their layout,
and available actions for a given user task. Usansswitch between perspectives

as they move across tasks.

When the plug-in programmer adds a visual componenthe workbench,
he must decide whether he wants to implement a wewan editor. How does

he decide this?

A view is typically used to create a file navigator, feo an editor, or to display
properties for the active editor. For example, @ag&sus there is a Navigator view
which allows browsing the contents of the workspa@mperties and outline
views are used to show information about an objectthe active editor.
Any modifications made in a view (like changing welof a property) are saved

immediately.

An editor is mostly used to edit or browse a document orutinpbject.
Modifications made in an editor follow an open-sal@se model, similarly

to any external file system editor. (Vogel 2009)
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4 DESCRIBING SWTBOT TEST CODE

This chapter uncovers SWTBot APl and explains thances of SWTBot test
program written as a practical part of the theskKleMenuTest.java
(see APPENDIX 2). FileMenuTest was designed to test File Menu onsti
It consists of 30 test cases and almost 1500 heode. Movie presenting the
tests running can be found APPENDIX 3.

4.1 The Skeleton of the Code

This chapter familiarises the reader with the baments of every SWTBot test,
and other issues that the test automation engsteernd be familiar with.

SWTWorkbenchBot offers API for testing Eclipse workbench itemselikiews,
editors and perspectives. What is also interestiege is that all non-constant
member variables in the code start with the una@eescrhis coding convention
comes from Java Sun™ Coding Standard. The ratiobalend it is that

it facilitates auto-completion (typing shows ask members only).
The drawback is that it reduces readability forgpammers not familiar with this
coding conventionMessage if assertion fails assertionFailedMessage is also
a member variable. It is utilized to store the ragss displayed when assertion

fails.

@BeforeClassannotation precedes a setUpBeforeClass() methdnVgeveral
tests need to share a computationally expensiugp stéte setup code can be put
inside its body. While this can compromise the pefelence of tests, sometimes
it is a necessary optimization. This method willrba once before any of the test
methods in the class. In the discussed test codeuised to instantiate the _bot
variable (of type SWTWorkbenchBot).

@AfterClass annotation precedes teardownAfterClass() methbdexpensive
external resources were allocated in BeforeClaghadethey have to be released
after all the tests in the class have run. All @#/ftlass methods are guaranteed to
run even if BeforeClass method throws an excepftidrerefore here the _bot
resource is released by setting it to null.
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@Before annotation causes the method setUp() to run bedvery @Test
method in the current class.

@After annotation precedes tearDown() method which isllysused to release
the resources (allocated in @Before method) dfiertést runs. This method will
execute even if the @Test method throws exceptionthe discussed code
a cleanup() method was put to assure the testpendence. The cleanup()

method will be covered in more detail later.

@Testannotation tells JUnit that the public void methodwhich it is attached

can be run as a test case. To run the method, flkd$hitonstructs a fresh instance
of the class than invokes the annotated method.eXagptions thrown by the test
will be reported by JUnit as a failure. If no extteps are thrown, the test

is assumed to have succeeded.

It is worth to mention thatach test class has its own workspacé there
is a need for the test to have a fresh workspdas & separate test class have
to be written. Otherwise the test methods inside same class will share

a common Workspace.

Javadoccomments are used throughout all the code alththugie are not many
comments inside the test methods. The reason ferthiat the author was taught
at work in NSN that the code itself should be cler@mugh not to need comments.
If there is a need for the comment — than writimptaer method or thinking
of naming variables and methods in more descriptigg should be considered.
The other reason is that the comments themselveente additional thing
to maintain. The author agrees with those rules taed to comply with them

the best he can.
4.2 SWTBot APl in Examples

The pieces of code gathered in this chapter folkmd of tutorial needed to get
familiar with the basics of SWTBot's API. Its magoal is to equip the reader
in the knowledge essential to be able to understaadcode ofFileMenuTest
from APPENDIX 2.
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42.1 Menu

/ICLICK ON A MENU ITEM
_bot .menu( "File" ).menu( "New").menu( "Test Hierarchy" ).click();

/ICHECK IF MENU ITEM IS ENABLED
assert True(_bot .menu( "File" ).menu( "Move..." ).isEnabled());

42.2 Views

//ISET FOCUS ON PARAMETER VIEW
_bot .viewByTitle( "Navigator" ).setFocus();

IISHOW VIEW
_bot .viewByTitle( "Navigator" ).show();

//PRINT LIST OF ALL VISIBLE VIEWS TO CONSOLE
ArrayList<SWTBotView> viewsList;
viewsList = new ArrayList<SWTBotView>( _bot .views());

if (viewsList.isEmpty())

System. out .printin( "\n\n>There is no view<\n\n" );
else {
System. out .printin( "There are " + viewsList.size() + " views
visible:" );
for (int i=0;i<viewsList.size(); i++) {

System. out .printin(viewsList.get(i).getTitle());
}

[[EXAMPLE OUTPUT:

/I There are 6 views available:
/I Navigator

/I Test Procedures

/I Parameter Types

/I Problems

/I Parameter

/I Outline

4.2.3 Editors

/IGET THE TITLE FROM EDITOR TAB
String thl = _bot .editorByTitle( "TestHierarchyl.xml" ).getTitle();

[IGET TEXT FROM EDITOR WITH GIVEN TITLE
String editorContents =
_bot .editorByTitle( "TestHierarchy2.xml" ).toTextEditor().getText();

/ISET TEXT INSIDE THE EDITOR
_bot .editorByTitle( "TestHierarchy3.xml" ).toTextEditor()
.setText( "My text here" );



/ICLOSE EDITOR TAB WITH A GIVEN TITLE
_bot .editorByTitle( "TestHierarchy4.txt" ).close();

/ISAVE EDITOR TAB WITH A GIVEN TITLE
_bot .editorByTitle( "TestHierarchy5.xml" ).save();

/ISET FOCUS ON THE EDITOR WITH A GIVEN TITLE
_bot .editorByTitle( "TestHierarchy6.xml" ).setFocus();

//IRETURN THE NUMBER OF EDITOR TABS
_bot .editors().size();

4.2.4 Windows

/ICHECK IF WINDOW IS ACTIVE
assert True(_bot .shell(  "New Project" ).isActive());

/ICLOSE WINDOW
_bot .shell(  "New Project" ).close();

/IGET ACTIVE WINDOW'S TITLE
String activeWindow = _bot .activeShell().getText();

425 Tree

//ISELECT A TREE ITEM (2 EQUIVALENT WAYS SHOWN)
_bot .tree().expandNode( "General" ).select( "Project" );
_bot .tree().expandNode( "General" ).expandNode( "Project” ).select();

//[SELECT A TREE NODE (INSIDE A VIEW)
_bot .tree(1).expandNode( "Projectl" ).getNode( "thl.xml" ).select();

/ICHECK WHETHER A TREE ITEM IS AVAILABLE

assert Tr ue(_bot .tree().getTreeltem( "slavel™ )!= null );
assert Tr ue( _bot .tree().expandNode( "slavel" ).select( "Properties" )=
null );

/ICHECK WHETHER A TREE LEAF IS AVAILABLE
assert Tr ue( _bot .tree().expandNode( "slavel” )
.expandNode( "Properties" ).getNode( "slaveName = slavel" )!I=  null );

/ICHECK IF TREE Projectl (INSIDE A VIEW) CONTAINS N ODE th1.xml
assert True(( _bot .tree(1).expandNode( "Projectl" ).getNodes())
.contains(  "thl.xml" ));
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/IGET THE NUMBER OF TOP LEVEL NODES (INSIDE A VIEW)
int topLevelNodes = _bot .tree(1).getAllltems(). length ;

/I[DELETE THE TOPMOST ITEM (INSIDE A VIEW)
_bot .tree(1).getAllitems()[0].contextMenu( "Delete" ).click();

4.2.6 Perspectives

[IACTIVATE A PERSPECTIVE WITH A GIVEN LABEL
_bot .perspectiveByLabel( "Run" ).activate();

/ICHECK IF PERSPECTIVE WITH A GIVEN LABEL IS CURREN TLY ACTIVE

_bot .perspectiveByLabel( "Test" ).isActive();

4.2.7 Buttons

//ICLICK BUTTON
_bot .button(  "Next >" ).click();

//[CHECK WHETHER A BUTTON IS DISABLED
assert Fal se(_bot .button(  "Finish" ).isEnabled());

4.2.8 Tool Bar Buttons

/ICLICK TOOL BAR BUTTON
_bot .toolbarButtonWithTooltip( "New" ).click();

/ICHECK WHETHER TOOL BAR BUTTON IS ENABLED
assert Tr ue( _bot .toolbarButtonWithTooltip( "New" ).isEnabled());

429 Check Boxes

/ISELECT CHECK BOX
_bot .checkBox().select();

4.2.10 Text Fields

//IWRITE TEXT INTO TEXT FIELD

_bot .textWithLabel( "Project name:" ).setText(  "MyTestProject3 1"

);
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//IREAD TEXT FROM TEXT FIELD
String text = _bot .textWithLabel( "Project name:" ).getText();

4.2.11 Time and Speed Control

[ISLEEP (VALUE IN MILLISECONDS)
_bot .sleep(1000);

/[SLOW DOWN THE EXECUTION OF TESTS (VALUE IN MILLIS ECONDS)
SWTBotPreferences. PLAYBACK DELAY = 100;

4.3 Error Recovery Implementation
In chapter 2.7 a standardised error recovery approas introduced to the reader

theoretically. In this chapter it will be explained practice. To understand what

error recovery does, a real situation will be urezed.
4.3.1 Test without Error Recovery

One of the developers accidentally checked-in aedbat caused creating new
Test Hierarchy files to stop working. More precysadlicking Finish button does

not create a Test Hierarchy file and does not clbee‘New Test Hierarchy’

window:

Test Hierarchy %g

Create a new Test Hierarchy resource.
==

Enter or select the parent folder:
IMyTestF‘miecM

File Mame IM_I,ITestH ierarchyd_ 1. sml

Advanced »> |

¢ Back | [l ERt | Firish I Cancel |

Figure 4 New Test Hierarchy window - Finish buttonstopped working
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As a result all the subsequent tests after thedd#st will also fail (see Figure 5)
because the focus stays on ‘New Test Hierarchy'desy not the default
‘Pegasus RCP’ that every test expects. After dealid&ing on the first failed test
one can see exactly in which line the test failad &ailure Trace gives a hint
about the reason of the failure. But all the consetjtests fail. Even the ones that
have nothing to do with creating Test Hierarchid@s fail in the first line of their
execution. This can be very confusing for the naamdr of the test who needs
to analyze the reason of the failure fast. In #ifisation it is difficult to isolate the
real reason of the failure and even worse — iasydo overlook some other bug
that might have appeared in the same time.

& Java - pegasus.core. swibottests/sic/pegasus/core/FileMenuT est java - Eclipse

File Edt Souce Refactor Nawvigate Search Projeet Run Window Help

I:fv‘-';ll I 4 I.??J:&:*G"{’JL{}}":E;@*]@L“?'}"Y 3 e ] T g
| 1§ Package Explorer | 'fg Hierarchy ‘m‘{ JUnik 22 =08 1] FileMenuT est java Ea =0
Fmisﬁgf:l after B2,761 seconds < cleanup ()2 ng
Lty ok D ’
Runs: 13/13 8 Erors: 10 B Faiues: 0 §
% Create a new test hierarchy.
I =
= FlebenuTest [Furier JUit 4] (52,626 ireer
Hnher
T el pegasus. core; FlleMenTes! i Al public void createlevTestHierarchyTest () {
IiereatsPrassusPrbiect eat (21361 createPegasusProject ("HyTestProject4”) ; J
createNewPegasusProjectU sing'izardT est (10,203 5] b B & i i

createMewGeneralProject Test [B,937 <)
| createMewT estHisrarchpTest (11,843 5
createMewSpsternConfigurationT est (5,500 5]
| createMewFolderTest 5,499 5]

| createNewDthertemsT est (5,500 <]

] closedndCloseAlTest [5.500 5|
saveTest (5,499 ¢

| savedlTest (5,500 3|

| saveticTest (5,500 <]

maoveT est (5,500 5]

L] rename (5499 5)

/% METHOD 1: File > New » Other... > Pegasus > Test Hierarchy */
createFileNewOtherWizzard("Pegasus", "Test Hierarchy", "MyTestPr

/% METHOD 2: File > New > Test Hierarchy */

createFileNewWizzard("Test Hierarchy", "New Test Hierarchy"”, "My
"MyTestHierarchyd Z.xml"™);

assertTestHierarchyWasCreated("HyTestHierarchyd z.xml")

/# METHOD 3: File » New Testhierarchy */
bot.menu("File™) .wenu("New Testhierarchy™).clicki);

= Faiue Trace =
I8/ or eclipse swibat swt finder exceptions WidgetHotF oundE keeption: Could not find wwdgat Fs ertContains ["New_Test", bot. EdltanYTlt le ("New Test'") .gerTicl

= &t orgeclipse. swibot, swh finder. 5w/ TE otF actory.wailntibidgets +menu("File") .menu(’ SEVE As...").elick():

= st oraeclipse.swtbot ecliose. finder 5w TwarkbenchBot. editor asgertTrredboboshelliToame: ks, o) wiskosive (L) 4

Figure 5 Execution of SWTBot tests without error reovery

4.3.2 Test with Error Recovery

The error recovery routine code is presented below:

try {
/IMETHOD BODY

}
catch (WidgetNotFoundException e) {
closeDialogWindow();

throw e€;

}
/**
* Closes dialog window if there is any (when 'Pega sus RCP'
*is not currently active shell).
*/
private  void closeDialogWindow() {

String activeShellName = _bot .activeShell().getText().trim();

String labelText = "Pegasus RCP"



38 (50)

if (lactiveShellName.equals(labelText)) {
_bot .shell(activeShellName).close();
}

}

The error recovery relies on taking the method biodly try-catch block. When
some unexpected situation occurs, usually WidgdiblmdException will
be thrown. In the catch block first information idogged that
the closeDialogWindow() method was entered. Thernalgorithm checks if there
is any dialog window opened so that it could makeattempt to close dialog
window (if any) to bring the application back te liase state and allow other tests
to continue. And at the end it rethrows the excepto be able to see its contents
for each failed test. A good proof of error recgvatgorithm correctness will

be running the tests again with this algorithm iempénted for every test:

f# Package Evplorer | fs Histarchy gfu Juric 52 = 0[] FieMenuTestiava 53 =0

Finished after 2101403 secands = G B El
= ([ * Create a new test hierarchy.
&9 e® | % Iy
Runs: 13413 8 Enors: 3 B Failwes: 0 BTest
public void createNenTestHierarchyTest () i
| try o

createPegasusProject ("HyTestFrojectd™)
= ] pegasus.core.FileMenuT est [Funner JUnil 4] (210,347 5]

g createPegasusProjectTest [2 331 5]
g createMewPegasusProjectU singw/izardTest (9,822 5]
£ createMewGeneralProjectTest (5,825 =)
£ createNewT estHisrarchyT est (11,687 )
g createMNewSystemConfigurationT est (15,187 <]
gk createNewFolderTest (31,053 =]
~EE createMewOtherltemsTest (20,278 5]
g clogebndClosedlTest (12,424 <)
£ saveTest (3,969 5]
£ savedlTest (39,062 5
~pE savebsTest (3328 )
g moveTest (34 540 ]
~-gEl rename [12.656 3]

/% METHOD 1: File » New » Other... » Pegasus » Test Hierarchy +/

createFileNewOtherWizzard ("Pegasus", "Test Hierarchy™, "MyTestPri

"MyTestHierarchyd 1.xml");
"

assertTestHierarch ated |

stHierarchyd 1.xml™);

/% METHOD 2: File > New > Test Hierarchy =/

createFileNenlizzard ("Test Hierarchy", "New Test Hierarchy", "Hy'
"File Mame", "HyTestHierarchy4 2.xml"):

assertTestHierarchyWasCreated{"NyTestHierarchyd_2.xnl") ;

/% METHOD 3: File > New Testhierarchy */
bot.menu("File™) .menu("New Testhisrarchy").clicki();
assertContainsi "Mew Test", kot.editorByTitle("Hew Test™).getTitls

= Failure Trace o bot.menu("File") .menu("3ave As...").click():

[ arg eclipse swtbot swt finder exceptions \idgeth otF oundE sception: Could nat find widget |~ 25557 tTrue{bot.shell ("3ave As...").isletive(}):

- " " :

= at org.eclipse. swtbat swt finder 5w/ T B otF actom.waitl ntitaidgetd bot.tree ”_ 'ExPﬁndNﬂd? (mHyTestProjectd”) .select () 4

= at org eclipse. swthot eclipse finder. 54w/ Ty orkbenchB ot editor St bot.textWichLabel ("File neme:").setText ("MyTestHisrarchyd 3.xml™

= &t org.eclipse. swibot eclipse finder 5w TwWorkbenchBat, editorBy] kot.button("Finish").click():

Figure 6 Execution of SWTBot tests with error recoery implemented

Now the behaviour of the test is correct. Only tbsts that use faulty feature
of creating new Test Hierarchies fail. For evenjethtest it is possible to see the

exact line in which the test has failed with cotretor messages.

4.4 Tests Independence Implementation

In compliance with the rules of well designed tesises - the tests
in FileMenuTest are independent of one anothers fteans each test method can
be executed separately of any other. It makesests tmore modular, simplifies

their maintenance and analysis after failure.
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4.4.1 Cleanup Method
Tests independence is achieved mostly thanks toclenup() method which

is placed in tearDown() method, therefore it isceked after each @Test method

even if it throws an exception. The cleanup() mdthas the following contents:

/**
* Performs cleanup needed after tests: close all o pened editors,
* reset perspective, delete all projects from Navi gator view.
*/
private  void cleanup() {
if ( _bot .menu( "File" ).menu( "Close All" ).isEnabled()) {
_bot .menu( "File" ).menu( "Close All" ).click();
}
_bot .menu( "Window" ).menu( "Reset Perspective..." ).click();
if ( _bot.shell( "Reset Perspective" ).isActive()) {
_bot .button(  "OK").click();
}
deleteAllFromNavigator();
}
}

4.4.2 Test Synchronisation

Consider the following code:
/**

* Wait until shell 'shellTitle' closes. Do nothing if it does
* not exist anymore.

*

* shellTilte
*/
private void waitUntilShellCloses(String shellTilte) {
try {
_bot .waitUntil(Conditions. shel | d oses( _bot .shell(shellTilte)));
}
catch (WidgetNotFoundException e) {
/*
* This have to be in empty catch block because waitUntil
* throws exception when window 'shellTitle' is not found.
* This window could be automatically closed af ter
* operation has finished.
*/
}

}

Sometimes there is need to use the waitUntil(...) hodt After confirming
execution of some costly operation (e.g. creatingew file), this operation can
take some time. If the next test would start tocexe, it would crash because the

focus would be still set to some dialog window oygress bar from previous test.
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First option to deal with such situation is usirg tsleep() method. But how
to know how long will it take for the program tanigh the operation? Setting

a fixed number of seconds seems very inflexible.

Much better option is using a SWTBot method desgigspecially to deal with
such cases:

_bot .waitUntil(Conditions. shel | A oses( _bot .shell(shellTilte)));

But once in few executions an unpleasant situaticours — the tests will crash.
The reason is that if the operation will finish cker and the window will close
sooner than expected, then_bot .shell(shellTilte) will  throw
WidgetNotFoundException. The only way to deal withs to catch it, write

a description why it was caught and log it. Andakethis is done in the code.
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5 ANALYSIS

5.1 Analysis of Capture/Playback Mechanism

Many GUI test tool vendors focus most of their mtittn on so called
capture/playback (also known as capture/replay or record/playback

methodology. Those terms are in common use althabgly are somewhat
confusing. Anyway, to know what exactly to do, tegecution tool needs a test

script, which is a program written in a programmiagguage.
5.1.1 Why Capture/Playback Is a False Economy?

A captured test is a linear script and it is famirgood solution for a number of

reasons, including:

1. The test script only stores inputs that havenbeeorded, not test cases.

So it does not know what the expected results @atieyou program it.
2. Small change introduced in the AUT can breaktrabgour scripts.

3. The captured script can only cope with precidbly same conditions
as when it was captured. Any unexpected eventdeatpg window shows

up because file already exists) will be interprededh bug.

4. In addition to performing operation on AUT, ttu®l users are endlessly
interrupted to insert verification points, testala@nd other check points.
This is labour intensive and tedious task. (Li, 2004, 20-21.)

There are situations when recorded test inputs maruseful in short term.
Captured tests can be acceptable for some teste e effort to update them
when the software changes is not very substariiat.they definitely will not
scale to hundreds or thousands of tests. (Grahaenandaal, Evans, Black 2007,
187-188.)

The record feature can generate a lot of code hig tode usually has

to be reprogrammed by the tester in order to iategit into the test. Therefore
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capturing tests does have a place but it is naiifsggnt in terms of automating
test execution. Decreasing test creation timegead idea but only if it does not
increase the cost of maintenance. Schemes thamisptithe test creation
at the expense of test maintenance will in factadase the life cycle costs instead
of reducing them. (Fewster, Graham 1994, 520.)

5.1.2 Recorder in SWTBot — a Marketing Stunt

On the home page of SWTBot project (Pedegaonka@)2@du can read:
“SWTBot can record and playback tests...”. But thehtris thatSWTBot lacks

a Recorder! The SWTBot developers were working under it inteely till
version 1.3 of the software. Since then it is nctively maintained, and even
Ketan Pedegaonkar himself discourages using ithénopinion of the author
of this thesis not having a Recorder is not a hgadlvantage. Recorder would
help only initially but once you need to start wigf reusable test modules, a

Recorder looses much of its value.

5.2 What Cannot Be Tested with SWTBot

While writing SWTBot tests, a lot of time can bested while trying to do things
that cannot be done. Things that will not be sufgabror are not implemented
yet. Therefore it seems a good idea to mention tinetmis thesis work, especially

that the author did not found any similar list oy énternet source:

There isno support for native widgets(Open/Save File Dialogs, Color

Dialogs, etc.).

« When trying to test AUT'srestart - it restarts also all the tests

and goes into infinite loop.
» Cannot access status bar text;

e Only partial support for close button x in the top right corner of every

window. One can use close method for shells bdaiis if there will
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be a confirmation dialog (which is a standard Esdipbehavior

for the main window).

» Cannot access context menu’s submenu itengs.g. in Navigator view).
There is a workaround - treat submenus as elenoémisiin context menu
- but it fails when in different submenus there @lments with repeating

names (e.g. “Other...").

5.3 Measuring Benefit of Using Automated Tests

The table below presents the comparison betweemmatic and manual tests.
It regards the test code from APPENDIX 2. It shaxecution time in seconds
of the consecutive tests which could also be oleskeion the movie attached
as APPENDIX 3. The author has also measured the 6f manual tests for
all the tests. The last column presents how mangdifaster the automated test

was.

Table 1 Comparison of Automated and Manual Tests Execution

Test N( Automated Test [s| Manual Test [s|Manual Test [s] / Automated Test [s]
1 2,454 61 24,9
2 3,471 134 38,6
3 2,141 56 26,2
4 1,732 48 27,7
5 1,844 72 39,0
6 1,207 64 53,0
7 8,002 231 28,9
8 8,157 57 7,0
9 7,828 249 31,8
10 3,561 144 40,4
11 8,203 61 7,4
12 14,032 487 34,7
13 14,000 398 28,4
14 8,156 228 28,0
15 2,157 61 28,3
16 63,735 419 6,6
17 8,282 211 25,5
18 8,125 274 33,7
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19 32,938 279 8,5
20 32,735 926 28,3
21 8,156 238 29,2
22 8,141 135 16,6
23 15,735 451 28,7
24 30,235 978 32,3
25 14,656 411 28,0
26 14,797 211 14,3
27 19,766 578 29,2
28 26,357 709 26,9
29 15,516 438 28,2
30 21,013 422 20,1
SUM =407,132 | SUM = 9031 AVG = 22,2

The last row summarizes results for all the teBtsecution of automated tests
takes less than 7 minutes (407.132 seconds) wiglesame manual tests would
take more than 2.5 hours (9031 seconds). This nthahsnanual tests were about

22 times more time consuming than the automatesl. tes

This doesn’t concern that the automated testsndegriated with Cruise Control's
nightly builds and the tests are executed autowmiftiovithout the need of
programmer’s intervention. Considering that thetetesvould have time to
perform those tests once a month rather than odeg,ahis difference is actually

much bigger.

Therefore how to measure the increase in quality® €uld calculate Return on
Investment (ROI) which should show the real valuat the automation gives.
The ROI value is not the value of automation verscost of executing tests
manually. It could be defined rather as the berddfthis type of testing plus the
benefit of whatever the manual tester is doing svhile automated tests are

executing. While calculating ROI one should take iaccount:
- the cost of executing automated tests consideniingstructure required
- The cost of maintaining the automation as thepcoevolves

- The cost of additional tasks required by autoomatfreviewing results,

maintaining documentation, training for staff, gtc.
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- ROI varies depending on the business environnagmiication under test,
and even the type of tests which were automated.

Calculating ROI for test automation project coutsldtopic for another bachelor
thesis and it is beyond the scope of this thess¢clwhas more development and
implementation nature. The other thing is thatab#hor is not allowed to disclose
any financial related data about NSN, thereforehwhese constraints it is

impossible to cover calculating ROI.
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6 CONCLUSION

As the reader of this dissertation had chance soodter, test programs written
using SWTBot are relativelgasy to read and intuitivefor people familiar with
basic concepts of Eclipse/Eclipse RCP. Without doybt SWTBot'sAPI is
large  enough to test effectively such complex applicatio
as Pegasus RCP. The biggest problem coulthdle of good documentation
and tutorials which makes it difficult to start witThe best and most up to date
iIs Javadoc that comes with SWTBot's code. Therefodeveloper which wants

to start writing SWTBot tests has to spend some tmith it to get familiar with

the API experimenting with the code. Although SWTBonot a commercial tool,
the growing community of testers and developers using it seems promising

considering the need of support.

Despite of what is published on SWTBot's home pa§WTBot lacks
a recorder. Apparently there is one, but it is not activelginained and its use
is discouraged even by the project’s lead develoetan Pedegaonkar. Lack
of recorder is not a big disadvantage since therder generates inflexible, non-
modular, non-reusable code which makes it rath@ca to have toy than serious
tool for test automation. Not having a recorder lingtes also that thester has

to be a programmer.

Automating tests has many benefits. The tests @amuh overnight allowing

to utilize hardware resources more effectiveBugs can be detected and
corrected much faster Developers could even execute automated GUI tests
before checking-in production code, without the chée wait for nightly build
tests’ results. Release tester can remove alragdynated tests from manual tests
list having more time to test new featuresather than retesting the old ones.
As the analysis has shown, the automated testsiexegertwenty times faster
comparing with manual tests. Considering that #ser would have time to
perform those tests once a month rather than odeg,ahis difference is actually
much bigger.
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Pieces of code presented in this document, ingngthow to achieve tests
independence, error recovery, test synchronizataggther with big test program
implementation which has almost 1500 lines of cOAEPENDIX 2) make up

a great tutorial which will help developers to dammiliar with SWTBot’s
capabilities. FileMenuTest.java consists of 30 wstes. The author has made
those tests compliant with all the objectives fallvdesigned test cases listed in
chapter 2.6. The tests proved to be reliable. Tdreywritten in a modular way
allowing for code reuse. The author will continus fwork as test automation
engineer. Goals for nearest future include creatitilifies abstract class with
most useful methods, preparing training about SWTBor developers

and tracking the latest trends in GUI test autoomati
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[* SimpleExampleTest.java */

package pegasus.core;

assert Enabl ed;

assert Visible;

throws Exception {

throws Exception {

import  static  org.eclipse.swtbot.swt.finder. SWTBotTestCase.
import  static  org.eclipse.swtbhot.swt.finder. SWTBotTestCase
. assert Not Enabl ed;

import  static  org.eclipse.swtbot.swt.finder. SWTBotTestCase.
import org.eclipse.swtbot.eclipse.finder. SWTWorkbenchBot;
import  org.junit.AfterClass;
import org.junit.BeforeClass;
import  org.junit.Test;
/**

* Simple test to prove SWTBot works

* mmazurki

*/
public class SimpleTest{

/**

* SWTWorkbenchBot

*/

private static SWTWorkbenchBot bot ;

/**

* BeforeClass

* Exception

*/

@BeforeClass

public  static void setUpBeforeClass()

bot = new SWTWorkbenchBot();

}

/**

* AfterClass

* Exception

*/

@AfterClass

public  static void tearDownAfterClass()

bot = null ;
}
/**

* Switch to Run perspective via the Open Perspec

*/

@Test

public  void openOtherRunPerspectiveTest() {
bot .menu( "Window" ).menu( "Open Perspective"
bot .table().select( "Run" );
bot .button(  "OK").click();

assert Vi si bl e( bot .toolbarButtonWithTooltip(
asser t Not Enabl ed( bot .toolbarButtonWithTooltip(
assert Enabl ed( bot .toolbarButtonWithTooltip(

/**

* Quick switch to Test perspective

*/

@Test

public  void openTestPerspectiveTest() {
bot .menu( "Window" ).menu( "Open Perspective"
bot .sleep(2000);

tive dialog

).menu( "Other..." ).click();
"New" ));
"Save As" ));
"Search" ));
).menu( "Test" ).click();
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